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1 — Introduction

1.1 Purpose and Scope

This document provides guidance for using the Earth Observing System (EOS) Data and Information
System (EOSDIS) Test System (ETS) Operations Management Data Simulator (OMDSIM).

1.2 Document Organization

Thisuser’ s guide comprises three sections. Section 1 gives an introduction to the document and its
conventions. Section 2 gives an overview of OMDSIM, and Section 3 describesin detail how to use
OMDSIM.

1.3 Assumptions and Conventions

Thisuser’s guide assumes that you have a basic familiarity with graphical user interfaces (GUIs) such
as OSF/Motif, Macintosh, or Microsoft Windows.

This user’ s guide assumes that a standard mouse will be used as the pointing device for controlling
theinteraction viathe OMDSIM GUI. Theinformation in this user’s guide appliesto any pointing
device (e.g., track ball, arrow keypad) that will work with a UNIX workstation in an equivalent way.

Therest of this section explains the conventions that this user’ s guide uses to explain OMDSIM
operation, and those that the OMDSIM user interface itself uses.

1.3.1 User's Guide Conventions

To indicate and represent certain kinds of OMDSIM user interface objects in the text, this user’ s guide
uses the following conventions:

 Text that you should enter appearsin the Cour i er typeface, with quotation marks around it.
(Do not type the quotation marks.)

* Pull-down menu options appear in italic.

» Pushbutton, radio button, and check button names appear in boldface type.

* “Click on” a GUI object means position the pointer (usually an arrow) over that object, and
press and release the left mouse button, without moving the mouse.

1.3.2 Overall Style

OMDSIM user interface objects that are standard OSF/Motif objects have the look and feel as
described in the OSF/Motif Style Guide (MSG), version 1.2. This section describes some of these
specifics.

OMDSIM includes some other kinds of user interface objects that are not described in MSG. These
have the look and feel of analogous objects in Microsoft (MS) Windows 3.1.1. Anexampleisalist
field — a combination of an editable text field, a down-arrow pushbutton, and a popup list. (Thelist
field resembles Windows' combination box — e.g., the MS Word font selector isacombination
box.)

1.3.3 General Conventions

Thetitle of awindow or dialog box identifies the user task that the window or dialog box supports,
and it may aso identify the primary action and specific focus of that user task.



Anélipsis (“...”) at the end of a menu option name or pushbutton label indicates that additional
information is needed for completion of the action that the option or pushbutton invokes. A dialog
box will appear to collect that information.

A highlighted border surrounding an object (e.g., atext field or pushbutton) indicates that the object
has keyboard focus, and that any key(s) you presswill apply to that object. For example, if a
pushbutton has keyboard focus, pressing the “Enter” key will activate that pushbutton. For another
example, if atext field has keyboard focus, anything you type will go into that field (except that the
“Enter” key has the behavior described above).

Any object that may be accessible or “clickable” under some conditionsis “grayed out” or “dim”
under conditionsin which it is not accessible.

1.3.4 Dialog Boxes

1.3.4.1 Primary dialog boxes

Some OMDSIM diaog boxes are controlled by the use of three pushbuttons:

» OK acceptsal input and changes, and closes the dialog box. Any actions you have specified in
the dialog are executed.

» Cancd closesthe dialog box without accepting any input or changes (unless you have
Applied or Set them; see Section 1.3.4.2). Cancel does not execute the task or any actions
that you may have specified in the dialog.

» Help initiates the display of information about how to use the task dialog box (and any relevant
subordinate dialog boxes).

The File Selection dialog box (Figure 1-3) is an example of a primary dialog box.

1.3.4.2 Multiple modification dialog boxes

Some diaog boxes allow for modifications of many of the same type of item. Whereitis practical, al
items are displayed at the same time for editing. If there are too many items or if they contain too
much information to be displayed in asimple way (e.g., several of the panelsin the OMD Editor,
Section 3.3.4), only oneitemis displayed at atime. These sections have a Next button and aPrev
(“Previous’) button to enable you to work on different items of the sametype. To display the next
iteminthelist, click on Next. To display the previousitem in thelist, click on Prev.

The dialog boxes with Next and Pr evious buttons also have Set and Reset buttons for making
your changes to an individual item. To save the valuesfor later use, click on Set. To restore the
parameters that were previously saved for that item, click on Reset.

1.3.4.3 Confirmation dialog boxes

Some user actions must be confirmed before they can be executed. For these actions, a Confirmation
dialog box (Figure 1-1) appears when you initiate the action.

Confirmation dialog boxes have Y es and No pushbuttons. To execute the action and close the
confirmation dialog box, click on Yes. If the action was initiated viaaclick on the task dialog box’s
OK pushbutton, the task dialog box isalso closed. To close the confirmation dialog box and return
to the task dialog box without executing the action, click on No.

1.3.4.4 Prompt dialog boxes

A prompt dialog box (Figure 1-2) is used to request more information.

Type the requested information into the field provided. To use that information, click on OK. To
cancel the action and avoid entering the information, click on Cancel.



All applications started by the ETS Menu
Controller will be terminated. Continue with
shutdown?

Yes

Figure 1-1. Confirmation Dialog Box (Menu Controller example)

Figure 1-2. Prompt Dialog Box (MPS example)

1.3.4.5 File selection dialog boxes

A file selection box (Figure 1-3) is used to select files for opening, saving, printing, and other
OMDSIM task activities. Most of the file selection boxes have the name of the activity included in the
title.

The Filefilter (e.g. “/userdkhaynes/a*”) appearsin thefield labeled “ Filter” at the top of the dialog
box. (A wildcard “*” indicatesthat al filesarelisted.) The “Directories’ section lists the directories
below the directory shown in the “Filter” field. (Accessto adirectory islimited to authorized users of
that directory.) The“File” section listsall filesin the directory that match thefilefilter.

To change thefilter and list only some of the filesin adirectory, just edit the “Filter” field and click on
the Filter pusnhbutton. The “Directories’ and “Files’ list boxes change to reflect the new filter.

To seefilesin adifferent directory, click on the desired name in the “ Directories’ section. To seethe
contents of the directory that is one level above the current directory, click on the®..” line. (A single
dot [“.”] isthe UNIX way of indicating the current directory; clicking on it will just redisplay the
directory information that you aready see) The“Filter” text field changes to reflect the new
directory, and the “Files” section changes to show thefilesthat are in the selected directory. The
“Directories’ section aso changes to show the subdirectories of the selected directory.

To select afileand useit in the OMDSIM task activity, either double-click on the filename or click on
the filename (which will then appear in the “ Selection” text area) and then click on OK. To closethe
file selection box without selecting afile, click on Cancel.



Filter

/users/khaynes/a:/#®

Directories Files

B | desktop

. fileid.dat
resource.frk finder.dat

savebox.gif

Selection

/users/khaynes/a:/] |
| 8] 4 | Filter Cancel

Figure 1-3. File Selection Dialog Box

1.3.4.6 Display-only dialog boxes

Some dialog boxes are used for display only, rather than control or data entry. These dialog boxes
have only a Close button (instead of OK, Apply, or Cancel) because there are no entries, changes,
or actions to accept, execute, or cancel.

Theinformation dialog box (Figure 1-4) is an example of a display-only dialog box.

Scenario File:

When a scenario file is activated, the Scenario File field is sensitized
and the name of the scenario file is displayed there. When the scenario has
completed executing, the Scenario File field and label are dimmed but its name

remains.

Figure 1-4. Display-only Dialog Box
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To close adisplay-only dialog box and continue with the task, click on Close.

1.3.5 Pull-Down Menus

Every menu title and many menu options have one character underlined. This character iscalled the
“mnemonic” (memory aid) for that menu or menu option. A mnemonic alows accessto that menu
and menu option via the keyboard.

A right-pointing arrow ([&) at the end of amenu option indicates that a cascade menu (a submenu)
will appear for selecting more details under that option.

1.3.6 Other Controls

1.3.6.1 Check buttons

A check button represents an individual option that can be either selected or not selected (either “on”
or “off”). A check button has alabel with a square to the left, which appearsraised (Figure 1-5a)
when the option is not selected (“off”) and appears darkened and recessed (Figure 1-5b) when the
option is selected (“on™).

[T Channel 1 _| Channel 2

a - Unselected b - Selected
Figure 1-5. Check Buttons

Check buttons may exist individually or in agroup, according to their meanings, but they are always
independent from one another (i.e., selecting or deselecting one has no effect on any of the others).
A check button may appear in awindow, dialog box, or pull-down menu. Select a check button by
clicking on either the square or the label.

1.3.6.2 Radio buttons

A radio button group represents a set of mutually exclusive options— i.e., only one of the options
can be“on” at any one time, and selecting one of the radio buttonsin a group automatically deselects
the radio button that was selected beforehand. Each radio button has a label with a diamond to the
left, which appears darkened and recessed when that particular option is selected. A radio button
group may appear in awindow, dialog box, or pull-down menu, and (except in amenu) may be
aligned horizontally (Figure 1-6a) or vertically (Figure 1-6b). Select aradio button by clicking on
either the diamond or the label.

Simulation Mode ————
|7A EDOS -, Spacecraft

a - Horizontal b - Vertical

Figure 1-6. Radio Buttons



1.3.6.3 Text fields

Text fields may be editable or not. Editable text fields (Figure 1-7a) appear recessed, and a text
insertion cursor (an “I-beam”) is visible within the field to show where the typed text will appear.
Text fields that cannot be edited (Figure 1-7b) do not appear recessed (although they may have a
rectangular border), and they do not contain atext insertion cursor.

Value CRC 3

a - Editable b - Non-Editable

Figure 1-7. Text Field

1.3.6.4 Spinners

A spinner (Figure 1-8) allows you the option of setting a value either by typing it into atext field or
by clicking on up or down arrow pushbuttons to increase or decrease the value shown in the text field
(usually £1 for each click).

Figure 1-8 Spinner

1.3.6.5 Panel sizing bars

Some windows have multiple panels that can be expanded and condensed via a panel sizing bar
(Figure 1-9). A horizontal line marks the separation between one panel and the next. A small square
at the right side of the horizonta line isthe panel sizing button. To expand or shrink apanel ina
paned window, move the mouse pointer over the sizing button, press the mouse button, and drag the
sizing button up or down until the panel has the size you want.

===
Figure 1-9. Panel Sizing Bar

To expand the panel above the bar, move the bar down. To expand the panel below the bar, move the
bar up. (Note: the bar cannot be moved if the panel isalready at itsfull height.)

1.3.6.6 List fields

A list field (Figure 1-10) is a combination of alabel, atext field, alist box, and a down-arrow
pushbutton. Y ou may type avalueinto the text field or select an item from the list.

Figure 1-10. List Field
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To activate the list, click on the down-arrow pushbutton. A list box showing the valid entries will
appear below the field, and the pushbutton will change to an up arrow. To select one of the items,
click on that item; to remove the list without changing the selected item, click on the up-arrow
pushbutton.

1.3.6.7 Auto/static fields

OMDSIM uses Auto/Static fields for setting the values of count parameters. The RLPC, FLSB, and
CCSDS VCDU panelsinclude settings for a substantial number of count parameters. For each count
parameter, you can specify that it be incremented automatically or remain constant for each successive
transmission from the same CODA Report template. To make the count increment automatically,
select the Auto radio button, and enter the increment and the period (in seconds) between applications
of that increment to the present value of the counter. To make the count constant, select the Static
radio button and enter its value.

Increase period

Flywheel CADUs . a0+ static I | I

Figure 1-11. Auto/Static Field (set to “Auto”)

Uncorrectable YWCDUs ~ 440

Figure 1-12. Auto/Static Field (set to “Static”)



2 — Operations Management Data Simulator (OMDSIM)
Introduction

2.1 Functional Summary

The ETS Operations Management Data (OMD) Simulator (OMDSIM) is a software application that
provides a source of OMD messages to supplement the capabilities of ETS-simulated mission data
generation and reception. In particular, OMDSIM supports Customer Operations Data Accounting
(CODA) reports, Spacecraft Contact Session (SCS) reports, PDS/EDS Delivery Records, and
PDS/EDS Acceptance Notifications. OMDSIM runson al three ETS hardware platforms. MPS,
LRS, and HRS.

Although OMDSIM is capable of operating without support from MPS, LRS, or HRS, it is designed
to communicate with the software of those ETS subsystems. Rather than requiring you to direct
OMDSIM to start and stop OMD transmission, OMDSIM is designed to receive such directives from
the other ETS subsystems. In thisway, the transmission of CODA and SCS reports are synchronized
with MPS/LRS/HRS processing and transmission of real-time and rate-buffered telemetry data, which
are being sent to the EOC.

In addition, OMDSIM
» Keepsalog fileof OMDSIM events
» Keegpsalog file of OMD transmitted and received
» Displays OMD transmission and reception events
* DisplaysOMDSIM status and anomal ous occurrences
* Maintains, displays, and logs OMD accounting statistics
* Respondsto received OMD (acknowledges receipt of EDS or PDS delivery record OMD)
» Accepts OMD from other EOSDI S test elements and logs their receipt

2.2 Operational Summary

Operation of OMDSIM involves four types of activities (listed here and described in later sections):
» Edablish the values of the data fields that congtitute the working OMD template

* Indicate atransmission schedule (the interval between transmissions and the duration of the
schedule) for the prepared OMD template

» Generate the signals to begin and terminate the testing phase of operations
» Delog the OMD transmitted and received

In the pretest phase of OMDSIM operation, you prepare OMD templates and establish transmission
schedules for upcoming test sessions. OMDSIM uses the data and information you provide in the
OMD template viathe OMD Editor panels and combines them with val ues either generated by
OMDSIM itsdlf or from quality and accounting information supplied directly by the hardware, asin
the case of the LRS and the MPS. The resulting OMD, based on the template directives and updating
fields, istransmitted to other EOSDI S elements through EBnet during a testing session.

OMDSIM places very few restrictions (other than data type) on the information you can place into the
OMD templates. For instance, a CODA has no consistency checks to ensure that the VCIDs used are



valid for EOS-AM1. Thisallowsyou to enter erroneous values to assess the error handling
capabilities of the entity that isreceiving the OMD.

Considerable data are associated with the various OMD simulated by OMDSIM, especially CODA and
SCSreports. In the case of the LRS, most of the information contained in the OMD is directly
supplied or derived from the quality and accounting indicators provided by the LRS hardware asiit
processes actual datareceived from an external source. Alternatively, you can control the setting of
valuesin the created and transmitted OMD by establishing an initial value and time-varying
relationship for each field in OMD templates using the OMD Editor panels. Thisisespecialy useful
for setting counters to increment over time. This scripting featureis used when OMDSIM isusedin a
standalone mode or when the hardware does not provide the specific data contents (e.g., on the MPS
platform). In the case of the LRS, hardware-provided values will override any value you might enter
into the OMD template.

A nominal transmission scheduleis associated with the EOSDIS OMD; some are transmitted on a
regular basis and others are triggered by a predecessor event. For example, CODA aretypically
transmitted by EDOS to the EOC every five seconds while real-time telemetry is active; an SCS report
issent by EDOS to the EOC within five minutes of the completion of rate-buffered services;
PDS/EDS ddlivery records are sent by EDOS to a DAAC within one minute of sending a data set; and
aPDS/EDS acceptance notification is sent by aDAAC to EDOS after the data set and delivery record
arereceived (15 to 45 minutes, depending on data set size). Y ou can specify the frequency and
duration of OMD transmission viathe OMDSIM Main Window (see section thd) or through the use of
scenario files (see sections thd and thd). Y ou may aso use a scenario file to create OMD using more
than OMD template in succession, each for a specified duration. This enables you to change the
contents or timing of the resulting OMD in a predetermined fashion. If you choose to schedule OMD
transmission by providing information only once, you will have no opportunity to change the
underlying OMD template while thetest isin progress.

During an OMDSIM test phase, OMD are transmitted and (possibly) received, depending on the test
configuration. OMD transmission is controlled by an internal schedule, either specified by you or tied
to internal signals associated with mission data. Y ou can signa the one-time transmission of a
selected OMD or specify the start and stop times of a transmission from the main window.
Alternatively, OMD transmission can be coordinated with internally generated signals, triggering the
synchronized starting and stopping of transmitted mission data or announcing the reception of adata
set. For the LRS, the MPS, and the HRS, OMDSIM receives a start signal when any real telemetry
format isfirst activated and receives a stop signa when telemetry isterminated. Inthisway, CODA
are sent out as long astelemetry is active, and when telemetry stops the summary SCSreport is
transmitted. For the HRS, signals are generatef for OMDSIM when a PDS/EDS isready for delivery,
which triggers adelivery record to be sent, or when a PDS/EDS is received, which triggers a
PDS/EDS acceptance notification to be sent. It isimportant to note that the activities required before
transmission can occur — creating and loading OMD templ ates, establishing the transmission
schedule, and (optionally) opening log files— must be completed before the expected start of the test
because OMDSIM will not recognize any signals from the hardware until these steps are complete.

During posttest operations, several log files created by OMDSIM are available for your analysis. All
OMDSIM events are time-tagged and recorded in an automatically created ASCI| text file, which can
be printed directly on any attached printer. An OMD logging function is available under the File menu
inthe OMDSIM main window. The delogging function is under the View menu of the OMDSIM
main window, and permits you to view or print any portion of the stored OMD log after logging is
complete.

When OMDSIM is operating with MPS, LRS, or HRS, scenario files can be loaded and executed,
and OMD of type CODA can be loaded and transmitted on a predetermined schedule. (Y ou can
modify the parameters for the OMD viathe OMD Editor.) Both scenario execution tests and OMD
transmission tests are controlled by signals from the smulator (MPS, LRS, or HRS) and by the
transmission interval, test duration, and SCS Summary delay fields. In addition, scenario execution



tests are controlled by the Start/Stop Scenario pushbutton, and OMD transmission tests are
controlled by the Start/Stop Transmission pushbutton.

2.3 Definitions

Throughout this section, the definitions outlined below have been adopted.

Counter — atype of OMD template message item, such as the number of CADUs received in a
CODA

L oading a scenario — the process of selecting a scenario file and preparing it to regulate OMD
transmission

Loading an OMD — the process of selecting an OMD template file and preparing it for OMD
transmission

OMD file— afile containing OMD template information

OMD template — the definition of the OMD elements and of the associated information for the
counter elements

OMD transmission — the activity that is started when you click on the Start Transmission
pushbutton. An OMD template fileisloaded and OMD are transmitted according to the
transmission interval and duration defined in the OMD Transmission panel of the OMDSIM main
window. OMD transmission ends when you click on the Stop Transmission button or
OMDSIM receives astop signa from MPS, LRS, or HRS.

Scenario execution — the activity that is started when you click on the Start Scenario
pushbutton. A scenario fileisloaded and is executed according to its directives. Scenario
execution ends when you click on the Stop Scenario button or the end of the scenario fileis
reached

Scenario file— afile whose records contain transmission interval, transmission duration, and
OMD filename

Summary delay — the number of seconds after the last OMD is transmitted or the
scenario/transmission is stopped (by you or by asignal from MPS, LRS, or HRS)

Test duration — the length of time that the current OMD is repeatedly updated and transmitted.
The test duration may be set to any positive integer value of time in units of minutes, but the
duration O has a special meaning; transmit only one OMD. The longest test duration is limited (by
the operating system) to be 231-1 (2,147,483,647) minutes.

Transmission interval — the number of seconds between successive transmission of OMD using
the current OMD template

2.4 Setup

2.4.1 Hardware Configuration

On the MPS, OMDSIM executes on the MVME-187 single-board computer with a PC display
executing the eXceed X Window System emulator software. On the LRS and HRS, OMDSIM
executes on a Hewlett-Packard workstation running the X Window System.

2.4.2 Software Configuration

The OMDSIM software comprises a user interface software component and other(s), which
communicate to enable you to initiate and control OMDSIM’ s functions. However, this software
structure does not affect how the OMDSIM is used, and this document does not discuss it further.
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2.4.3 Files and Environment Variables

OMDSIM depends on a number of predefined files and environment variables.

The OMDSIM scenario file contains records with a minimum of three fields that are separated by any
standard "C" language delimiters (one or more blanks, one or more tabs, one or more line feeds, etc).
Thefields are, in order:

» Timeinterval in seconds between CODA transmissions (an integer value)
» Duration in minutes of the transmission (an integer value)
* Fully qualified name of the OMD template file to be used for this duration

OMDSIM requires an OMD template for any transmitted OMD. The template file provides the default
valuesto be used in the transmitted OMD for fields that are to remain constant, and it supplies
controlling information about the optional fields of OMD. For LRS and HRS, the hardware supplies
the contents of the OMD fields. For MPS, the contents of all OMD fields are simulated rather than
hardware-supplied, so the OMD template can also be used to script ramping functions for various
counters and data qudity fieldsin a CODA or SCS OMD transmission scenario. Y ou create the OMD
template using the OMD Editor, which you invoke from the Setup menu in the OMDSIM main
window. See sectionsthbd for information on creating an OMD template, defining OMD contents, and
loading an OMD template.

OMDSIM uses the contents of the OMD template only as a source of data values for transmitted
OMD. These contents do not control any aspect of the actual OMD transmission. For example,
specifying the destination field in the ground message header of a CODA template will not cause the
OMD to be sent to that destination, because that function is controlled by the environment variables
OMD_TRANSMIT_TOHOSTNAME and OMD_TRANSMIT_PORTNAME. Thisgivesyou the
flexibility to inject errorsinto the OMD.

OMDSIM generates asession log file, which is created when OMDSIM starts. Itsnameis
<timestamp>.omd_log, where <timestamp> is the start time of OMDSIM. Every entry that appearsin
the status log area of the OMDSIM main window is stamped with its time of occurrence and is entered
into the session log.

OMDSIM can also create alog of all OMD received and transmitted (see sections tbd and tbd). These
log files are created in the directory designated by the ETS PROC_LOG_DIR environment variable.
Thefiles may be delogged at the completion of atest using the OMD delogger (see section thd).

Table 2-1 showsthe OMDSIM environment variables and their expected values.

2.4.4 Starting OMDSIM

To start OMDSIM, use the predefined command provided by the system administrator to bring up the
ETS Menu Controller, and click on the OMDSIM pushbutton in the Menu Controller (see section thd
for details about the Menu Controller).

Alternatively, you can enter “ondsi ni at the UNIX command line prompt. The Menu Controller,
however, is the recommended method. It issimpler because it sets up the execution environment
automatically and does not require any intervention from you.
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MPS Environment Variable

Expected Value

Menu controller variables

ETS_ICON_FILE
ETS_TEMP_DIR

ETS execution variables

ETS_HELP_DIR
ETS_LOG_DIR
ETS_OMD_DIR
ETS_PARAMS_DIR
ETS_PROC_LOG_DIR
ETS_SCN_DIR
ETS_SUBSYSTEM

OMDSIM variables

OM_DELOG
OM_RECEIVER
OM_RECEIVER_SUB
OM_SCENARIO_MANAGER
OM_SCHEDULER
OM_TRANSMISSION_TASK
OMD_RECEIVER_PORTNAME

OMD_TRANSMIT_PORTNAME

OMD_TRANSMIT_TOHOSTNAME

OMDSIM_HOSTNAME

OMDSIM_PORTNAME

$ETS_RUN_ROOT/runtime/mmc_sample_icon_file
$ETS_RUN_ROOT/runtime/temp

$ETS_RUN_ROOT/runtime/help
$ETS_RUN_ROOT/runtime/log
$ETS_RUN_ROOT/runtime/omd
$ETS_RUN_ROOT/runtime/params
$ETS_RUN_ROOT/runtime/log
$ETS_RUN_ROOT/runtime/scenario

“MPS” or “LRS” or “HRS” (uppercase text string,
without quotes)

$ETS_RUN_ROOT/om_delog
$ETS/RUN/ROOT/om_receiver task
$ETS/RUN/ROOT/om_receiver_sub
$ETS/RUN/ROOT/om_scenario_manager
$ETS/RUN/ROOT/om_scheduler
$ETS/RUN/ROOT/om_transmission_task

port number of socket on which incoming OMD may
received from other EOSDIS test elements

port number on which outgoing OMD of type CODA
are to be transmitted via UDP protocol

host name of destination device, as known to domain
name server resident on MPS, LRS, or HRS
computer

name of host computer executing the MPS, LRS, or
HRS user interface component (i.e., the MVME-
187)

port number of socket on which MPS, LRS, or HRS
user interface communicates with OMDSIM

Table 2-1. OMDSIM Environment Variables and their Expected Values

2.5 Operational Overview

2.5.1 Main Window

When you start OMDSIM, the OMDSIM main window(Figure 2-1), appears. The main window
provides access to OMDSIM functions and presents status information and important configuration
information. On startup, the contents of the fieldsin the main window are blank and the
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File Setup View
Scenario Execution

Scenario File hsioA.scn

Record
Executing:

Summary Delay (sec) g0

I Start Scenario
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A
i

IT
IF
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I?

—r
OMD Beceived

Time Msg Type

—r
OMD Transmitted

Time Msg Type 5eq No.

- 5

96 261 14:19:55
om_scenario_managetr_stub: loading scn

file

Figure 2-1. OMDSIM Main Window
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The OMDSIM main windowcontains five panels:

Scenario Execution provides control and status information about the OMDSIM scenario being
executed. This panel is accessible after a scenario file has been loaded.

OMD Transmission provides control for individual OMD transmission. Thispanel is
accessible after an OMD file has been |oaded.

OMD Received provides information on the most recent OMD received. Thispand is
available only when received OMD are being logged to afile.

OMD Transmitted provides information on the most recent OMD transmitted. Thispanel is
available only when transmitted OMD are being logged to afile.

The gtatus log area at the bottom includes process status, command directives, and errors.
Every entry in the log is stamped with the time of its occurrence. This panel isaways
available. (See section 3.1.5 for details.)

See Section 3.1 for details on using the OMDSIM main window and its panels.

2.5.2 File Menu

The OMDSIM File menu (Figure 2-2) provides access to disk files and communication links
associated with the OMDSIM.

Close Comm Link

Load Scenario...

F Log OMD Received
F Log OMD Transmitted

Figure 2-2. OMDSIM File Menu

The OMDSIM File menu provides the following functions:

Open Comm Link — Enable/initiate communications with EBnet and MPS (required for
scenario and OMD loads). (See Section 3.2.1 for details.)

Close Comm Link — Close/terminate communications with EBnet/MPS (loading scenarios
and OMD no longer possible). (See Section 3.2.2 for details.)

L oad Scenario — Select a scenario file and prepare it for execution. (See Section 3.2.3 for
details)

Unload Scenario — Remove the current scenario file from the execution context. (See
Section 3.2.4 for details.)

Load OMD — Select an OMD template file and prepare it for execution. (See Section 3.2.5
for details.)

Unload OM D — Remove the OMD template file from the execution context. (See Section
3.2.6 for details.)
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Log OMD Recelved — Storeinto alog file arecord of all OMD that OMDSIM receives
(required for responding to incoming OMD). (See Section 3.2.7 for details.)

Log OMD Transmitted — Storeinto alog file arecord of al OMD that OMDSIM transmits.
(See Section 3.2.8 for details.)

Exit — Shut down the OMD Simulator; close/terminate any open communicationslinks. (See
Section 3.2.9 for details.)

2.5.2 Setup Menu
The OMDSIM Setup menu (Figure 2-3) provides for setting up a scenario that OMDSIM can execute
or an OMD filethat it can transmit.

Open Scenario...
New OMD >

Open OMD...

Figure 2-3. OMDSIM Setup Menu

The Setup menu provides the following functions:
Open Scenario — Create or edit a scenario file. (See Section 3.3.1 for details.)
New OMD:

CODA Report — Create anew CODA report template file. (See Section 3.3.2.1 for
details.)

PDS Delivery Record — Create anew PDS delivery record template file. (See Section
3.3.2.2 for details.)

EDS Delivery Record — Create a new EDS delivery record template file. (See Section
3.3.2.3 for details.)

Open OMD — Select and open an OMD template file. (See Section 3.3.3 for details.)

2.5.2 View Menu
The OMDSIM View menu (Figure 2-4) provides for viewing logs of received or transmitted OMD.

OMD Logs...

Figure 2-4. OMDSIM View Menu

2.5.2 Help Menu
The OMDSIM Help menu (Figure 2-5) provides help on using the OMDSIM main window.

on context...

Figure 2-5. OMDSIM Help Menu
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The OMDSIM Help menu options provide the following functions:
About OMDSIM — Display help about the OMDSIM main window in general.
On context — Display help about a specific area of the OMDSIM main window.

2.6 Operational Procedures and User Tasks

OMDSIM can generate OMD of varioustypes. When using OMDSIM with MPS or LRS, you will
most be generating CODA; when using it with HRS, you will be generating OMD associated with
PDS and EDS delivery and receipt. On all of these systems, you initially establish the content of the
OMD (except EDS and PDS acknowledgments) by creating templates using the various OMD editors
available from the OMDSIM Setup menu. These templates contain the information that is constant for
the duration of the test and parameters for generating information that istime varying during the test.
The templates generally alow you great freedom in selecting the vaues to be transmitted in the
corresponding OMD so that with few exceptions, anomalous conditions that are presently unforeseen
may be introduced. Y ou may, for instance, use the template to create CODA that indicate that the
spacecraft ID isEOS-PM 1, when all other indications and formatsin the CODA are vaid for EOS-
AML

OMDSIM fills the contents of CODA and SCS reports very differently, depending on whether it is
running on the MPS or on the LRS or HRS. The LRS and HRS are used to process external sources
of return- and forward-link data. Thus, the quality and accounting indicators that go into the CODA
and SCS OMD message are obtained directly or are derived from data supplied by the hardware.
CODA and SCS reports accurately reflect the processed data on the LRS or HRS, and you do not
have the option of overriding OMD values provided by the hardware. For the MPS, however,
contents of CODA and SCS reports are completely ssimulated. Therefore, for the MPS you may
simulate the values of the counters using information entered into the template. In general, you
specify avalue as static (constant) for the duration of the template, or as automatic (ramping) to be
incremented over a period by an amount you specify. The amount of time to increment avariable can
be independent of the CODA transmission timeinterval.

In broad overview, you direct the course of the OMD transmissions, both in the sense of determining
the values that are to be placed in the OMD sent to other EOSDIS elements and in timing the
transmissions. Many of the tasks involved are automated or may require information established and
saved only once before any specific test.

Assume that a useful OMD template exists and is available for use in aspecific test. Y ou have two
options to execute the test:

The most straightforward test is the transmission test. A transmission test involves the following

steps:

1) Establish communication with entities outside OMDSIM: From the File menu, select the Open
Comm Link option.

2) Load an OMD template: From the File menu, select the Load OMD option and specify the OMD
file namein the dialog box.

3) Set the OMD transmission parameters. Inthe OMD Transmission panel of the OMDSIM main
window, set an interval between subsequent OMD transmission events and set a duration for the
test.

4) Start OMD transmission: Click on the Start Transmission pushbutton or wait for the signal
from MPS/LRS/HRS (when telemetry is started).

5) Endthetest: Click onthe Stop Transmission pushbutton or wait for the stop signal from
MPS/LRSHRS.

16



The other test method is scenario execution. It provides more flexibility than the transmission test
because you can chain together more than one OMD template (seridly) to transmit different OMD
during the test. Y ou can also transmit more than one OMD template (serially) during the test.
Scenario execution involves the following steps:

1) Createascenariofile: From the Setup menu, select the Open Scenario option. (See section
3.1.4.3 for the format of an OMDSIM scenario file)) Ensure that the OMD files you referencein
the scenario file actualy exist.

2) Establish communication with entities outsde OMDSIM: From the File menu, select the Open
Comm Link option.

3) Load ascenariofile: From the File menu, select the Load Scenario option and specify the scenario
file name in the dialog box.

4) Set scenario execution parameters. In the Scenario Execution section of the OMDSIM main
window, set the delay after the last OMD transmission for the test summary to be transmitted.

5) Start scenario execution: Click onthe Start Scenario pushbutton or wait for the start signal
from MPS/LRS/HRS (when telemetry is started).

6) Endthetest: Click onthe Stop Scenario pushbutton, wait for the stop signal from
MPS/LRS/HRS (when telemetry is stopped).

The OMDSIM File menu provides the following additional functions:

» Unload OMD and Unload Scenario alow you to “undo” the OMD or scenario preparation. To
load adifferent OMD or scenario before starting transmission or execution, you must first
unload whatever is |oaded.

* Log OMD Received enables the monitoring and logging of incoming OMD. This option must
be enabled if OMDSIM isto respond to incoming OMD.

* Log OMD Transmitted option provides arecord of OMD transmitted during the session.
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3 - Using OMDSIM

3.1 Main Window

The OMDSIM main windowconsists of five panels (Figure 2-1). Normally, not al of these are
visible smultaneoudly. This section discusses the panels separately, although more than one of them
may be visible. In each of the figures about the panels, abrace (*}”) to the side of the screen picture
indicates the specific panel that the section covers.

To show or hide al or part of the Scenario Execution panel or any of the OMD panelsin the OMDSIM
main window, use the panel sizing bar (see section 1.3.6.5). The status log panel is alwaysvisible.

3.1.1 Scenario Execution Panel

The OMDSIM Scenario Execution panel (Figure 3-1) provides the interaction for controlling the
execution of scenarios. The Scenario Execution panel is active when a scenario is loaded (see the
Load Scenario option in the File menu, Section 3.2.3).

The Scenario Execution panel shows the name of the scenario file that is being executed. A scenario
may call for a sequence of more than one OMD template to be used to generate OMD in succession,

EEIe Setup View

Scenario Execution

Scenario File jb.scn

Record
Executing:

scenario file
/users/khaynes/runtime/scenario/jb.scn

96 338 11:40:37 Interval 2 sec, Duration
1 min

Figure 3-1. Scenario Execution Panel (OMDSIM Main Window)
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each with different characteristics, so this panel lists each record in the scenario file asit is executed.
(Once an OMD fileis specified, subsequent records in the scenario file may contain directives for how
the OMD template is to be modified for the following transmission sequences.) Before starting the
scenario, you can use the “Summary Delay” spinner” to change the summary delay. The Summary

Delay isthe interval in seconds between the transmission of the last OMD and the transmission of the
SCSviaKerberos FTP (KFTP) to other EOSDI S test elements.

To execute the scenario, click on the Start Scenario pushbutton.

While the scenario is executing, the pushbutton has the name Stop Scenario. To stop the scenario
before it has finished executing, click on Stop Scenario.

If you wait for the scenario to play itself out or for OMDSIM to receive astop signal from MPS (sent
by MPS when telemetry generation is stopped), the scenario will end by itself.

Note: If you stop the scenario, either by using the Stop Scenario button or by stopping MPS
telemetry generation, the test summary will not be transmitted. The test summary is transmitted only
when the scenario playsitself out because it is assumed that you will start another scenario again,
continuing the transmission of OMD soon &fter the interruption.

When the scenario ends, the Scenario Execution panel is no longer active, and itsfields and controls
aredim and unavailable.

If the scenario ended by being stopped before completion, the Load OMD and Load Scenario options
in the File menu are available again immediately. If the scenario ended by playing to completion, the
summary delay will determine the number of seconds before those options are available again,
because a scenario is not considered fully complete until its test summary has been transmitted.

3.1.2 OMD Transmission Panel

The OMDSIM OMD Transmission panel (Figure 3-2) provides the interaction for controlling the
transmission of asingle OMD template. The OMD Transmission pand is active when an OMD
template file is loaded (see the Load OMD option in the File menu, Section 3.2.5).

The OMD Transmission panel shows the name of the OMD template file that is being used to guide
OMD transmission and generate OMD counter values. A single type of OMD may be transmitted
using the dialog available on this panel, according to the “interval” and “duration” values. (The
characteristics of the template cannot be changed from this panel during the course of atest —i.e.,
after you have clicked on Start Transmission.) Before starting OMD transmission, you can use
the various spinners to change the transmission duration, transmission interval, or summary delay.

To transmit OMD, click on the Start Transmission pushbutton. Alternatively, you can wait for
OMDSIM to receive asignal from MPS/LRSHRS that telemetry generation has been started. (If you
click on the Start Transmission pushbutton before telemetry generation has begun, the signal from
MPSLRS/HRS will have no effect on OMDSIM.)

While the transmission is proceeding, the pushbutton has the name Stop Transmission. To stop
the transmission before it has finished, click on Stop Transmission. Alternatively, you can wait
for OMDSIM to receive asignal from MPS/LRS/HRS that telemetry generation has been stopped. (If
you click on the Stop Transmission pushbutton before telemetry generation has ended, the signal
from MPS/LRS/HRS will have no effect on OMDSIM.)

When the transmission is compl ete, the OMD Transmission panel is no longer active, and its fields
and controls are dim.
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| File Setup View

OMD Transmission

OMD Filel jb.coda

Transmission Duration (min) 5
Transmission Interval {sec) g

Summary Delay (sec) ‘gp

I Start Transmission

96 338 11:41:0F OM_TR: Load OMD received
96 338 11:41:07 OM_TR: LOAD OMD
/users/khaynes/runtime/omd/jib.coda
received

from USR_INTERFACE

e

Figure 3-2. OMD Transmission Panel (OMDSIM Main Window)

3.1.3 OMD Received Panel

The OMD Received Panel (Figure 3-3) displaysinformation about OMD that OMDSIM receives. The
OMD Received Pand is active only when OMDSIM islogging the OMD it receives (see the Log OMD
Received option in the File menu, Section 3.2.7).

This panel contains no controls, and is for information display only.
3.1.4 OMD Transmitted Panel

The OMD Transmitted Panel (Figure 3-4) displaysinformation about OMD that OMDSIM transmits.
The OMD Transmitted Pandl is active only when OMDSIM islogging the OMD it transmits (see the
Log OMD Transmitted option in the File menu, Section 3.2.8).

This panel contains no controls, and is for information display only.

3.1.5 Status Log Panel

The OMDSIM Status Log Panel (Figure 3-5) shows the OMDSIM messages that indicate the status
and progress of OMDSIM activities.
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OMD Received
Time Msg Type

Seq it Source

it Ack. Expected it Ack. Received

:F

96 338 11:43:32 OM_BRECEIVER: log UMD to
/users/khaynes/runtime/1log/96338114332.rc

vd_log
96 338 11:43:32 Server spawned pid 15732

Figure 3-3. OMD Received Panel (OMDSIM Main Window)

OMD Transmitted
Time | 21:46:52 Msg Type CODA

Seqit 2 Destination  EDO

—r
96 338 11:41:07 OM_TR: Load OMD received
96 338 11:41:07 OM_TR: LOAD_ OMD
/users/khaynes/runtime/omd/jb.coda

received
from USR_INTERFACE

Figure 3-4. OMD Transmitted Panel (OMDSIM Main Window)
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Figure 3-5. Status Log Panel (OMDSIM Main Window)

OMDSIM stamps each status log entry with its date and time of occurrence and recordsitinalogfile.
When you start OMDSIM, it creates the status log file and gives it a name that includes the date and
time of the beginning of the OMDSIM session.

The Status Log panel shows four lines or more, in time order. To see earlier or later messages, use
the scroll bar along the right side of the panel. To change the number of lines shown, resize the
window vertically.

3.2 File Menu Functions

The OMDSIM File menu provides options for access to disk files and communication links associated
with the OMDSIM.

3.2.1 Open Comm Link

The Open Comm Link option in the OMDSIM File menu opens a communications link to the entities
with which OMDSIM needs to communicate (EBnet and MPS/LRSHRS). OMDSIM checks all
communications ports and enables communications with external systems (EBnet and
MPSLRS/HRS). You must open acommunications link before you can load a scenario or an OMD
file.

When a communications link is open, thisitem is named Close Comm Link (see Section 3.2.2).

OMDSIM actsasaclient process to MPS/LRSHRS, and connects via socket with MPS/LRS/HRS
when you select Open Comm Link. Y ou can make this connection any time after MPS/LRS/HRS has
been invoked; you can break it (via Close Comm Link) and reestablish it without affecting the
MPS/LRSHRS. (The environment variable ETS SUBSY STEM must be set to “MPS,” “LRS,” or
“HRS’ to enable the communication with the MPS, LRS, or HRS, respectively.)

3.2.2 Close Comm Link

The Close Comm Link option in the OMDSIM File Menu terminates communications with the entities
with which OMDSIM has been communicating (EBnet and MPSLRS/HRS).

When acommunications link is closed or before alink has been opened, this menu item is named
Open Comm Link (see Section 3.2.1).
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3.2.3 Load Scenario

The Load Scenario option in the OMDSIM File menu enables you to select ascenario file to be
prepared for execution. Select the desired scenario file from the Load Scenario File dialog box
(Figure 3-6). (See Section 1.5.5 for details on using file selection dialog boxes.)

Only one scenario can be loaded at any one time, and both a scenario and an OMD file cannot be
loaded simultaneously. Therefore, the Load Scenario option is available only when no scenario or
OMD fileisloaded; it is dim otherwise.

3.2.4 Unload Scenario

The Unload Scenario option inthe OMDSIM File menu removes the current scenario from the
OMDSIM execution context. The Unload Scenario option is available only when a scenario isloaded;
itisdim otherwise. If ascenario isloaded, you must unload it before you can load an OMD file.

3.2.5 Load OMD

The Load OMD option inthe OMDSIM File menu enables you to select an OMD file to be prepared
for transmission. Select the desired OMD file from the Select OMD File dialog box (Figure 3-7).

| | |
— Load Scenario File — Select OMD File

Filter Filter

wwnes/runtime/scenario/* khaynes/runtime/omd/*

Directories Files

time/scenario/. |{SllihsioA scn

time/scenario/.. that.scn

Directories Files

@l dh1.codal|f

itime fomd/..

Selection Selection

runtime/omd/kdh1.codd

itime/scenario/hsioA.scr]

Figure 3-6. Load Scenario File Figure 3-7. Select OMD File
Dialog Box Dialog Box
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Only one OMD file can be loaded at any one time, and both a scenario and an OMD file cannot be
loaded s multaneoudly. Therefore, the Load OMD option is available only when no scenario or OMD
fileisloaded; it is dim otherwise.

3.2.6 Unload OMD

The Unload OMD option in the OMDSIM File Menu removes the currently loaded OMD file from the
execution context. The Unload OMD option is available only when an OMD isloaded; itisdim
otherwise. If an OMD fileisloaded, you must unload it before you can load a scenario.

3.2.7 Log OMD Received

The Log OMD Received option alows you to direct OMDSIM to start or stop storing into alog filea
record of all OMD that OMDSIM receives. This menu option isacheck button, and it reflects the
current status of OMD Received logging.

When you start OMD Received logging, OMDSIM opens afile whose name consists of the time the
log was started with the extension “.rcvd_log”.

When you stop OMD Received logging (i.e., when you select this option while OMDSIM received
logging is proceeding), OMDSIM stops logging OMD received and closes the log file.

If OMD received are being logged, OMDSIM responds to PDSEDS Delivery Record OMD by
sending PDS/EDS A cceptance Notification OMD; these are generated and transmitted entirely without
any action on your part.

Log OMD Received is available only when acommunications link is open (see Section 3.2.1).
When OMD Transmitted logging ends, you can use the delogger to view the contents of the log file.
See Appendix A for details.

3.2.8 Log OMD Transmitted

The Log OMD Transmitted option allows you to direct OMDSIM to start or stop storing into alog file
arecord of all OMDsthat OMDSIM transmits. This menu option isacheck button, and it reflects the
current status of OMD Transmitted logging.

When you start OMD Transmitted logging, OMDSIM opens a file whose name consists of the time
the log was started with the extension “.trans_log’”.

When you stop OMD Transmitted logging (i.e., when you select this option while OMDSIM
transmitted logging is proceeding), OMDSIM stops logging OMD transmitted and closesthe log file.

Log OMD Transmitted is available only when acommunications link is open (see Section 3.2.1).
When OMD Transmitted logging ends, you can use the delogger to view the contents of the log file.
See Appendix A for details.

3.2.9 Exit

The Exit option in the OMDSIM File menu terminates the OMD Simulator and closes any open
communication links. If any transmission tests are active, the OMDSIM Exit Confirmation Dialog
Box (Figure 3-8 appears, to ask you to confirm the termination.

To complete the exit procedure and terminate OMDSIM, click on Yes. To cancel the termination and
leave OMDSIM active, click on No.

3.3 Setup Menu Functions

The OMDSIM Setup menu provide options for creating or modifying a scenario that OMDSIM can
execute or an OMD filethat it can use in transmitting OMD.
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A transmission test is currently active.
Communications cannot be terminated until it is
stopped. Stop the Transmission Test?

Figure 3-8. OMDSIM Exit Confirmation Dialog Box

3.3.1 Open Scenario

The Open Scenario option in the OMDSIM Setup menu allows you to select and open a scenario file
for editing. Select the desired scenario file from the Select File dialog box (Figure 3-9) and click on
OK. To create a new scenario, simply enter the name of anew file into the “ Selection” text field.

The Scenario Editor window (Figure 3-10) appears, and you can edit the selected scenario file. The
Scenario Editor window uses the text editor that is set in your UNIX environment variable

| |
— Select file

Filter

untime/scenario/#*.scn

Directories Files

A ib.sen

iefscenariof.. solar.scn

Selection

nes/runtime/scenario/]

Figure 3-9. Select Scenario File dialog box
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vi jb.scn -

]

users/khaynes/runtime/omd/jb.coda

users/khaynes/runtime/omd/jb.coda

users/khaynes/runtime/omd/jb.coda

F O S P A B Il R

"/users/khaynes/runtime/scenario/jb.scn" line 1 of 9 —11%—

Figure 3-10. Scenario Editor

EDI TOR; if thisvariable is not defined in your environment, the Scenario Editor window uses the vi
editor (asin the example below). (Seeyour text editor manual for instructions on how to edit the
scenario file.) The Scenario Editor window closes when you quit or exit the text editor.

The OMDSIM scenario file contains records with aminimum of three fields that are separated by any
standard C language delimiters (one or more blanks, one or more tabs, one or more line feeds, etc).
Thefields are, in order:

* Timeinterva in seconds between CODA transmission (an integer value)
e Duration in minutes of the transmission (an integer value)
* Fully qualified name of the OMD template file to be used for this duration

Ensurethat all OMD template filenames you specify in the scenario file refer to filesthat actualy exist.

3.3.2 New OMD

The New OMD option in the OMDSIM Setup menu alows you to create anew OMD templatefile.
This option has a cascade menu (Figure 3-11) that requires you to identify the type of OMD template
fileto be created.

CODA Beport
PDS Delivery Record

EDS Delivery Record

Figure 3-11. OMDSIM Setup “NEW OMD” Cascade Menu

After you have selected atemplate file type, the OMD Editor (see Section 3.3.4) appears, initiaized
with values from the default file for the selected OMD type. If the default file doesn’t exist, OMDSIM
alertsyou that it will initalize all the fieldsto zero, and the OMD editor isinitiaized with zeroesin
every field of the requested OMD type. Y ou may now modify these values.
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The default file nameis given by the environment variable ETS_DEFAULT (which is the nominal
“DEFAULT”) and has the extension matching the OMD type (“. coda”, “. pds”, or “. eds”). The
OMD templatefiles are located in the directory given by the environment variable ETS OVD DI R

3.3.2.1 CODA Report

See Section 3.3.4.1.2 for details on how to specify values for CODA Report OMD.
3.3.2.2 PDS Delivery Record

See Section 3.3.4.1.3 for details on how to specify values for PDS Delivery Record OMD.
3.3.2.3 EDS Delivery Record

See Section 3.3.4.1.3 for details on how to specify valuesfor EDS Delivery Record OMD.
3.3.3 Open OMD

The Open OMD option in the OMDSIM Setup menu allows you to select and open an existing OMD
template file so that you can examine and/or change its values. Use the Select OMD File dialog box
(Figure 3-12) to choose the OMD file to open. The OMD Editor (see Section 3.3.4) appears with the
fields displaying the values specified in the selected file.

— Select OMD File
Filter

khaynes/runtime/omd/*

Directories Files

Al dh1.codalf

itimefomd/ ..

Selection

runtime/omd/kdh1.codd

Figure 3-12. Select OMD File Dialog Box
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OMD template files are located in the directory given by the environment variable ETS OMD_DIR
and have file name extensions corresponding to the OMD type they represent. The extension must
reflect the OMD type for further processing to occur.

3.3.4 OMD Editor

The OMD Editor window appears after you select Open OMD or New OMD from the OMDSIM Setup
menu (see Sections 3.3.2 and 3.3.3, above). The OMD Editor window consists of panels (Figures 3-
13 through 3-24) that display logical or functional parts of the OMD (according to the specific OMD
type being edited).

3.3.4.1 OMD Editor Panels

The entire set of OMD Editor panelswill probably be larger than can fit on the screen, so the OMD
Editor window has scroll barsfor scrolling the full display. Each OMD type has a different collection
of panels. For an existing file, the OMD Editor identifiesthe OMD type from the file extension; for a
new OMD, the type you selected from the New OMD cascade menu (Figure 3-11) determines the
OMD type.

The collection of panelsfor each OMD typeisasfollows:

» CODA Report
- Ground Message Header Panel (Section 3.3.4.1.1)
- CODA Report Content Indicators Panel (Section 3.3.4.1.2.1)
- Return Link Physical Channel Panel (Section 3.3.4.1.2.2)
- Forward Link Processing Function Panel (Section 3.3.4.1.2.3)
- CCSDSVCDU Service (Section (3.3.4.1.2.4)

» PDSDdivery Record
- Ground Message Header Panel (Section 3.3.4.1.1)
Exchange Date Unit Label Pandl (Section 3.3.4.1.3.1)
- PDS Delivery Record Label Panel (Section 3.3.4.1.3.2)
- PDS Ddlivery Record PVL Statements Panel (Section 3.3.4.1.3.3)

» EDSD¢dlivery Record
- Ground Message Header Panel (Section 3.3.4.1.1)
Exchange Date Unit Label Panel (Section 3.3.4.1.3.1)
- EDSDélivery Record Label Panel (Section 3.3.4.1.3.2)
- EDS Delivery Record PVL Statements Panel (Section 3.3.4.1.3.3)

The following sections discuss all the OMD Editor panelsin order, from the top to the bottom of the
window. The panelsfor the PDS and EDS Delivery Report OMD messages are identical, so they are
described together.

3.3.4.1.1 Ground Message Header Panel

All OMD types have the Ground M essage Header panel (Figure 3-13), the first panel in the OMD
Editor. This panel displaysthe header valuesin the current OMD template file (using default values if
the OMD template is new).
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GROUND MESSAGE HEADER

Source EDO |; Destination SMC |;

Message Type CODA | Test

Mission’s Spacecraft ID  AM—1 I Flag Bit

Figure 3-13. OMD Editor Ground Message Header Panel

Use the Source list field to sdlect the source of the OMD, and use the Destination list field to select its
destination. (See Section 1.3.6.6 for details on using list fields.)

The “Message Type” field shows the type of OMD you are editing. Y ou cannot change this value:
The OMD are always transmitted as this type.

The “Mission’s Spacecraft ID” field shows the spacecraft name for the OMD you are editing. You
cannot change this value.

To indicate whether or not thisOMD isatest OMD, select or deselect the Test check button. (The
test option is set by default.)

To remove the date and time from the OMD, select the Flag Bit check button.

3.3.4.1.2 CODA Report Editor Panels

The OMDSIM OMD Editor provides four panels for modifying CODA Report parameters. the CODA
Report Content Indicators panel (Figure 3-14), the Return Link Physical Channel (RLPC) panel
(Figures 3-15 through 3-17), the Forward Link Status Block (FLSB) panel (Figure 3-218) and the
CCSDSVCDU Service panel (Figure 3-19).

The RLPC, FLSB, and CCSDS VCDU panels include settings for a substantial number of count
parameters. For each count parameter, you can specify that it be incremented automatically or remain
congtant for each successive transmission from the same CODA Report template. To makeit
increment automatically, select the Auto radio button, and enter the increment and the period (in
seconds) between applications of that increment to the present value of the counter. To make it
constant, select the Static radio button.

3.3.4.1.2.1 CODA Report Content Indicators Panel

The CODA Report Content Indicators panel (Figure 3-14) sets the makeup of the CODA report.

Thefirst section determines which of the five optional sections of information the CODA report will
contain (only return link, forward link and CCSDS VCDU service information are applicable to EOS-
AM1). Toinclude aspecific section of information in the CODA report, select the check button for
that kind of information. To remove a section of information from the CODA report, deselect its
check button.

Once you have specified the sections, one CODA Report Editor panel becomes available for each
section of CODA Report information. Each panel is active and available only if itsinformation typeis
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CODA REPORT CONTENTS
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[T CCSDS Path Service
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Ground Location ID EDO F

Figure 3-14. CODA Report Content Indicators Panel

selected; it isdim otherwise. (However, the OMD Editor / CODA Report Editor retains all settings
and valuesin an inactive/unavailable panel until you exit the editor, and if you make an inactive panel
active by selecting its kind of information in the CODA Report Content Indicators panel, those
settings and values are displayed.)

The second section of the CODA Report Content Indicators panel provides an opportunity for the user
of the OMDSIM system to enter the Ground Location ID portion of the SCS ID from the list assigned
by EDOS. The default value for thischoiceis“ETS’.

3.3.4.1.2.2 Return Link Physical Port Status Block

The Return Link Physical Channel panel (Figures 3-15 through 3-17), is active when the CODA
Report contents include the Return Link data.

Thefirst section in the RLPC panel (Figure 3-15) allows you to set the number of Return Link
Physical Ports (RLPPs), or RLPF TGT Ports, that will beinthe OMD. Usethe“Number of RLPPS’
spinner to set this number, which may be 0 to 2.

The second section of the RLPC panel (Figures 3-15 and 3-16) allows you to set parameters for one
or more individual RLPPs. To select a specific RLPP, either enter its number into the “RLPP
Number” field or click on the Next or Prev pushbuttons until you see the RL PP number you want.

Enter and/or select the values and options for the RLPP (as described below). The settings for an
RLPP include the settings for al VCIDs in that RLPP (see the paragraphs on setting VCID values and
options, below), and you must set the V CIDs before setting the RLPP.

To save the entered values, click on the Set pushbutton. (Y ou must save the valuesif you want
OMDSIM to usethem.) To restore the values and options to their previously saved settings, click on
the Reset pushbutton. (The Set and Reset pushbuttons are both dim when you haven’t changed
any of the values and thus there aren’t any changes to be set or reset.)

Y ou can set the RLPP count parameters to be incremented automatically or to remain static. To make
the count static throughout the test, click on the Static radio button and specify a count value in the
“vaue’ field. To make the count ramped automatically during the test, click on the Auto radio button
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Figure 3-15. Return Link Physical Channel Panel (1 of 3)

and enter the desired valuesin the “increase” and “ period” fields. “Increase” isthe number that is
added to the count after the specified period, and “ period” isthe time in seconds between successive
updates to the count.

An RLPP may contain zero to eight (O to 8) Virtual Channel IDs (VCIDs). Use the “Number of
VCIDs’ spinner to set this number. (See Section 1.3.6.4 for details on the use of spinners.)

The last section of the RLPP panel (Figure 3-17) alows you to set parameters for one or more
individual VCIDsinthe RLPP. To select a specific VCID, either enter its number into the“VCID
Number” field or click on the Next or Prev pushbuttons until you see the desired VCID number.

Enter and/or select the values and options for the VCID (as described below).

To save the entered values, click on the Set pushbutton for the VCID and then click on the Set
pushbutton for the RLPP. (IMPORTANT: You must save the values by clicking on the Set
pushbuttons in both the VCID and RLPP areas if you want the values to be in thetemplate.)) To
restore the values and options to their previously saved settings, click on the Reset pushbutton. (The
Set and Reset pushbuttons are both dim when you haven’t changed any of the values and thus there
aren’t any changes to be set or reset.)

To make the count static throughout the test, click on the Static radio button and specify a count
valuein the“value’ field.

To make the count ramped automatically during the test, click on the Auto radio button and enter the
desired valuesin the “increase” and “period” fields. “Increase’ isthe number that is added to the

31



File

neriod

Frame Sync Pattern Errors . 2o
: neriod
CADUs Received ., ato
Flywheel CADLs
Frame Sync Losses + ao

Uncorrectable Y CDOUs ~ a0

YCDUs with CRC Errors + st

Number of ¥ ClDs IT

v

Figure 3-16. Return Link Physical Channel Panel (2 of 3)

File

VCID Number @ 1

Correctable VCDUs » ann o stat

Symbols Corrected + ano  + stat

Figure 3-17. Return Link Physical Channel Panel (3 of 3)

count after the specified period, and “period” is the time in seconds between successive updates to the
count.
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3.3.4.1.2.3 Forward Link Status Block Panel

The Forward Link Status Block (FLSB) panel (Figure 3-18) is active when the CODA Report

contents include the Forward Link data.

Set the counters for the FLSB overall and for the number of Forward Link Physical Ports (FLPPs).

This panel shows all available FLPPs, so it does not include Set, Reset, Next, and Prev

pushbuttons. To set the values for a particular FL PP, ensure that the number of FLPPsin the FLSB
includes the desired FL PP, and change the desired fields.

= OMD Editor — [DEFAULT .codal

File

FORWARD LINK STATUS BLOCK

NMumber of FLPPs

. TGT/EGTID ;
EDOSID | ¢
. TGT/EGTID
EDOSID | ¢
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EDOS ID | ©

increase

Out of Sequence Msg #s . a0 » static 4 |

CD B S L .-'-"-utlj
Transferred

CD B S L .-'-"-utlj
Transferred

CD B o wr Ato
Transferred

neriod

A Static

A Static

- Static

neriod

i

increase

increase

neriod

neriod

neriod

Figure 3-18.

Forward Link Status Block Panel

3.3.4.1.2.4 CCSDS VCDU Processing Panel

The CCSDS VCDU pandl (Figure 3-19) is active when the CODA Report contentsinclude the

CCSDSVCDU data. Thefirst section of this panel alows you to set the number of VCIDsto be
included in the reports generated from this template. The number of VCIDs should be consistent with

the number of V CIDs represented throughout the CODA, but there is no operational constraint to

makeit soin OMDSIM. For the sake of testing, you may establish information for up to eight (8)
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Figure 3-19. CCSDS vCDU Panel

VCIDs. For each VCID you may enter smulated counter information for the number of VCDU
Sequence Count Discountinuities and for the count of stored return-link VCDU EDUsfor thisVCID.

To make a count static throughout the test, click on the Static radio button and specify a count value
inthe“vaue” field.

To make a count ramped automatically during the test, click on the Auto radio button and enter the
desired valuesin the “increase” and “period” fields. “Increase’ isthe number that is added to the
count after the specified period, and “period” is the time in seconds between successive updates to the
count.

Note: The VCIDsrelevant to CCSDS VCDU processing are different from the VCIDs relevant to
RL PPs.

3.3.4.1.3 PDS and EDS Delivery Record Editor Panels

EDS Delivery Records and PDS Delivery Records are used by the ETS HRS subsystem to provide
additional information about Expedited Data Sets (EDSs) and Production Data Sets (PDSs). After
filesfor aPDS or an EDS are successfully transferred to aDAAC, ETS sendsto the DAAC the
EDS/PDS Delivery Record, providing notification of the data set’s presence. The EDOS Ground
Message Header identifies whether this message isa PDS or an EDS Delivery Record.

The EDS/PDS Delivery Record consists of an EDOS Ground Message Header, an Exchange Data
Unit Label, an EDS/PDS Delivery Record Label, and EDS/PDS Delivery Record PVL Statements.

Figures 3-20 through 3-24 depict the OMD Editor panels for the EDS/PDS Delivery Record OMD.
Like the CODA Report panels, some of these panels contain Set, Reset, Next, and Prev buttons

for subsections and Auto and Satic options for count parameters. These features are operated and
behave in the same way for both types of OMD.
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Exchange Data Unit Label Panel PDS/EDS Delivery Record Label Panel

Figure 3-20. Exchange Data Unit Label Panel and
PDS/EDS Delivery Record Label Panel

3.3.4.1.3.1 Exchange Data Unit Label Panel

The Exchange Data Unit Label pandl (Figure 3-20, left side) allows you to set 20 bytes of
identification information in ASCI| text format.

Y ou can modify six elements of the label; figure 3-20 shows the default set of “correct” values,
needed as part of the DAAC required format. (OMDSIM also caculates as part of the exchange data
unit label the length in ASCII of the PDS/EDS Delivery Record Label and PVL statements, including
white space.)

3.3.4.1.3.2 PDS/EDS Delivery Record Label Panel

The PDS/EDS Délivery Record Label panel (Figure 3-20, right side) allows you to set 20 bytes of
identification information in ASCI| text format.

Y ou can modify six elements of the label; figure 3-20 shows the default set of “correct” values,
needed as part of the DAAC required format. (OMDSIM also calculates as part of the exchange data
unit label the length in ASCII of the PDS/EDS Delivery Record Label and PVL statements, including
white space.)

3.3.4.1.3.3 PDS/EDS Delivery Record PVL Statements Panel

The PDS/EDS Delivery Record PVL Statements (Figures 3-21 through 3-24) represent the operations
management data specific to groups of files (PDS or EDS) representing one data set, the first of which
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PDS/EDS DELIVERY RECORD PVL STATEMENTS

Originating System OMDS IM

Consumer System [ECS

DAN Sequence Number 300132

Product Name PDS

Mission |

Aggregate Length

Mumber of File Groups

i

|

P e,

e O,

D B T T B T e T

Figure 3-21. PDS/EDS Delivery Record PVL Statements (1 of 4)

File Group 1 | I S ot I?%éﬂ;@%ﬁ
Data Set ID | Next | Prev

Number ID J o
Data Structure ﬂ I; i v

APID 1 AM1 0001

APID 2 AM1 0nn2

APID 3 AM1 000b

Creation Time 59631 FO90345

Figure 3-22. PDS/EDS Delivery Record PVL Statements (2 of 4)
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Data Type

Descriptor NOT USED

Data Version
Node Name lecs.gsfc.nasa.gov
Beginning Date/Time 1996—11-12T09:03: 45
Ending Date/Time 1996—11-12T12:43:20

Mumber of files 3

Figure 3-23. PDS/EDS Delivery Record PVL Statements (3 of 4)

File Spec

Directory NOT USED

Filename P04202890420291AAAAA

File Type METADATA

File Size 13279

Figure 3-24. PDS/EDS Delivery Record PVL Statements (4 of 4)

is the construction record. One group consists of aminimum of two files, the construction record and
the data proper. Since the number of filesis generally unknown, you may establish template

37



information for up to 25 groups of up to eight (8) files. Asshown in these figures, most of the PVL
information is constant (e.g., mission spacecraft ID) or occasionally updated (e.g., node name of
destination computer on which the data set filesreside). Y ou are expected to create suitable templates
(onetime) for creating delivery records specific for the test data, and to update them (infrequently) as
testing requires.

Certain fields in the PDS/EDS delivery record, such as the delimiters between file information and
group information, are maintained by OMDSIM, and you cannot modify them.

3.3.4.2 OMD Editor Menu Functions

3.3.4.2.1 OMD Editor File Menu Functions
The OMD Editor File menu (Figure 3-25) provides for creating and accessing OMD template files.

Figure 3-25. OMD Editor File Menu

3.34.2.1.1 New

The New option in the OMD Editor File menu displays a cascade menu (a submenu) that asks you to
select the OMD type (Figure 3-26). The OMD Editor window isinitialized with the default parameters
for the OMD of the type you selected. (For more information, see section 3.3.2.)

CODA Beport
PDS Delivery Record

EDS Delivery Record

Figure 3-26. OMD Editor New OMD Cascade Menu

3.3.4.2.1.2 Open

The Open option in the OMD Editor File menu brings up afile selection dialog box. To usethe OMD
valuesfrom afile, select an OMD file from thefile selection dialog box and click on OK.

3.34.2.1.3 Save

The Save option in the OMD Editor File menu savesthe current OMD parameters to the samefile from
which they were read or the file to which they were most recently saved. The filewill include any
changes you have made to the parameters. No dialog box appears because no further action from you
isrequired. (If the OMD templateis new, afile selection dialog box will appear to request afile name
and directory for the new OMD file.) (See Section 1.3.3.4 for details on using file selection dialog
boxes.)
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3.3.4.2.1.4 Save As

The Save As... option in the OMD Editor File menu alows you to save the current OMD parameters
to adifferent file name. Select or enter the desired OMD file name in the Save File As dia og box.
The OMD file name extension must reflect the OMD type: “.coda,” “.pds,” or “.eds’.(See Section
1.3.3.4 for details on using file selection dialog boxes.)

3.34.215 Load

The Load option in the OMD Editor File menu causes the current OMD file to be |oaded into memory
to wait for the next transmission signal. If the current OMD template has no file name associated with
it (has not been saved after modification) afile selection dialog box (Figure 1-3) appearsto request a
file name. (See Section 3.2.5 for a description of loading an OMD file.) Y ou cannot load an OMD
filewhile atransmission test is active or a scenario is being executed.

3.3.4.21.6 Exit

The Exit option in the OMD Editor File menu terminates the execution of the OMD Editor software.
It closes the OMD Editor window and any open OMD Editor dialog boxes.

If the current OMD file has been modified but has not been saved, a question dialog box pops up to
ask you if you want to save the OMD file. To save the OMD and close the OMD Editor, click on
Yes. To closethe OMD Editor without saving the OMD file, click on No. To cancel the exit and
return to the OMD Editor (without saving the OMD file), click on Cancel.

3.3.4.2.2 OMD Editor Help Menu Functions

The OMD Editor Help menu options alow you to get information about using the OMD Editor
window.

3.3.4.2.2.1 About OMD Editor

The About OMD Editor option inthe OMD Editor Help menu allows you to get help on the OMD
Editor window in general. When you select this option, an information dialog box appears with
information about the top-level OMD Editor Help window. (For an example of an information dialog
box, see section thd.)

To close the OMD Editor Help window, click on Close.

3.3.4.2.2.2 On context

The On context option in the OMD Editor Help menu allows you to get help about a specific area of
the OMD Editor window. The pointer changes shape to a hand with the index finger extended. To
select the area of the OMD Editor window for which you want information, click on that area, using
the tip of the index finger as the indicator.

3.4 View Menu Functions

3.4.1 OMD Logs

The OMD Log option in the OMDSIM View menu allows you to view log files of OMD received or
transmitted by OMDSIM.

When you select OMD Log, afile selection dialog box appears. The OMD Received log has a
filename extension of “.rcvd_log” and the OMD Transmitted log has an extension of “.trans log”.
Select one of these logs to be viewed and click on OK.
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A terminal window appears (Figure 3-31), executing the om_delog program. Follow the procedures
outlined in Appendix C to use om_delog. The om_delog program storesitsresultsin an ASCII disk
filethat isnamed “OM_Delog” and islocated on your workstation in the directory from which
OMDSIM was started. The OM_Delog file can be viewed through any ASCII text editor or printed
through any print utility.

Important: The om_delog program aways saves the results of delogging in the file named
“OM_Delog’. If youwant to view thelogs of both OMD received and OMD transmitted, you must
view one before you delog the other. Otherwise, when you delog the second type of OMD,
om_delog will overwrite the delog of the first type of OMD, and the first delog will be lost.

Delog all CODA found [v/n] => ¥

All headers will be presented.

Delog Return Link Status Block [v/n] => ¥

If data is available it is possible to delog up to 8 RLPP.
Number of RLPP to delog —> 2

For RLPP #1, please enter the NUMBER of
virtual channels that you wish to delog (1-8) -> 2

For Return Link Physical Port #1

Delog frame sync pattern errors [y/n]
Delog number of CADUs received [y/nl]
Delog number of flywheel CADUs [w/n]
Delog num of frame sync losses [v/nl
Delog no of uncorrectable VCDUs [y/n]
Delog no of VCDUs with CRC chk [y/n]

Figure 3-27. om_delog Terminal Window

The OMD L og option does not reguire communication with any process external to OMDSIM and so
isaways available.

3.5 Help Menu Functions
The OMDSIM Help menu (Figure 3-28) enables you to obtain information about OMDSIM.

About OMDSIM
on context...
Figure 3-28. OMDSIM Help Menu

3.5.1 Help About OMDSIM

The About OMDSM option in the OMDSIM Help menu enables you to get help on OMDSIM in the
form of abrief description of the OMDSIM process. An information dialog box appears with this
information. To close the dialog box, click on Close.

To close the information dialog box, click on Close.
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3.5.2 Help On Context

The On Context option in the OMDSIM Help menu enables you to get help on OMDSIM in the form
of information about a particular item in the OMDSIM window. Select On Context and the mouse
pointer turns into a pointing hand. To obtain help on an item or a section of the window, place the
index finger of the pointing hand over theitem and click. Aninformation dialog box appears with the
information about that item or window area.

To close the information dialog box, click on Close.
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Appendix A —om_delog

A.1 Purpose

The om_delog utility is provided as part of OMDSIM as an aid to verifying the contents of CODA and
other OMD that have been transmitted and logged to abinary file, and OMD that have been received
from other EOSDIStest elements. To bringing it up, select the OMD Log option from the View menu
on the OMDSIM main window. A dialog box appearsthat is set by default to the directory designated
to contain log files by the system administrator, and the file selections are filtered, again by default, to
show only files that have the extension .trans log. Thesefiles are the binary files containing a
recapitulation of the CODA transmitted and saved.

Thefile names aretime tags, and it is possible to rename any of them to more meaningful
identifications or move any to more appropriate locations for later analysis. Y ou may highlight a
selection, then choose OK to bring up the delogger, or double-click on a selection.

A.2 Initialization Flags

The delogger prompts you in a hierarchical manner to minimize the delog output. At the highest level
you may choose to delog all CODA found by responding "y" to the query "Delog al CODA found
[y/n] ->" The option to delog any of the (optional) CODA status blocks present is then shown. |If
you select to delog Return Link Status Blocks by typing in"y" to the next prompt, then you will be
prompted to supply the maximum number of return link physical ports for which you desire delogged
information. For AM-1, up to 8 are possible. For each RLPP you will be asked if you wish to delog
counters for one or more (up to 8) virtual channels. For each, you will be sync pattern error counter,
the number of CADUSs received, the number of CADUs received when in flywheel mode, the number
of frame sync losses, the number of uncorrectable VCDUSs, and the number of VCDUs with CRC
check. For each virtual channel for each of each return link physical port, you may choose to delog
the number of correctable VCDUSs by VCID and the number of corrected VCDUs by VCID.

Next, the prompt to delog the optional Forward Link Status Block is presented. If you select this,
prompts are given to delog the number of command blocks received, the number of command blocks
discarded and the number of out of sequence ground message headers. Y ou may then select to delog
counters for up to 8 FLPP. For each, you will be prompted to delog the number of command blocks
transferred.

Next, you will be prompted to delog the CCSDS VCDU Processing Status Block. Y ou may select to
delog counters from 1 to 8 virtual channels. For each, you may delog the count of sequence
discontinuities and the number of return link VCDU EDUSs.

Other OMD may be delogged if they are present in the log file. The delogger prompts you to select
delogging of EDS/PDS Delivery Records, and finally, you may choose to delog the contents of the
Session Contact Summary Report. The information in the Ground message header is displayed to the
termina device, and the sections that you have selected are written, along with the header information,
to the file named OMD_delog in the default directory.
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Appendix B - ETS Menu Controller

B.1 Starting Up the ETS Menu Controller

To start the Menu Controller for the ETSMPS or LRS, enter “et s_nps” or“et s_| rs” at thelogin
prompt. The ETS Menu Controller Window will appear:

— ETS MPS <]
Multimode Operations
Portable Management
Simulator Data
Executive Simulator
MPS Exec OMDSIM

Figure B-1. ETS Menu Controller Window (MPS)

The pushbuttonsin the ETS Menu Controller window represent the ETS applications that can be
executed on the ETS subsystem with which you are running OMDSIM.

B.2 Starting an ETS Application

To start an ETS application that isinactive, click on the pushbutton for that application.
Note: ETS applications are initially inactive and must be started when this window first appears.

Note: If youtry to start an application that is aready active, ETS will interpret the pushbutton click as
acommand to terminate the application. To recover, cancel the termination (see section 2.1.5.3 for
details).

B.3 Terminating an ETS Application

To stop an active ETS application, click on the pushbutton for that application. Clicking on the button
of an active application starts its termination process. A dialog box asks you to confirm termination:

Do you really want to terminate the Operations
Management Data Simulator OMDSIM application?
Any unsaved data will be lost.

Yes Cancell

Figure B-2. ETS Application Termination Confirmation Dialog Box
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To terminate the application, click on Yes. To cancel the termination and leave the application active,
click on Cancel.

Note: If you try to terminate an application that is not active, ETS will interpret the pushbutton click
as acommand to start the application. To recover, click again on the application’s pushbutton in the
Menu Controller window and follow the above instructions for termination.

Warning: Terminating applications viathe Menu Controller is ashortcut. An application terminated
in this way does not have the opportunity to ask you about saving any data or files. For asafer
aternative, select the Exit option from the File menu of the application’s main window.

B.4 Shutting Down the ETS Menu Controller

To shut down the ETS Menu Controller and any active applications, select the Close option from the
window menu of the Menu Controller window. (To bring up the window menu for any window,
click onthe squarewith abar init —, in the upper left corner of the window.) If no applications are
active, the window will be closed immediately and the Menu Controller terminated.

If there are active applications, the ETS Menu Controller Shutdown Confirmation dialog box (Figure
2-3) will appear to request confirmation of the termination.

All applications started by the ETS Menu
Controller will be terminated. Continue with
shutdown?

Yes Cancell

Figure B-3. ETS Menu Controller Shutdown Confirmation Dialog Box

To continue the ETS MPS/LRS shutdown, click on Yes. All active applications will be terminated as
if you had requested and confirmed their termination through the Menu Controller. To cancel the
shutdown and leave the application(s) active, click on Cancel.

Warning: Terminating applicationsin thisway isashortcut. An application terminated in thisway
does not have the opportunity to ask you about saving any data or files. For asafer aternative, select
the Exit option from the File menu of the application’s main window.



Abbreviations and Acronyms

APID
ASCII
BER
C&DH
CADU
CCSDS
CLCW
cmd
CODA
COP
CRC
DAAC
DRAM
DSN
EBnet
EDOS
EDS
EDU
EOC
EOS
EOSDIS
ESDIS
ETS
FLPP
FLSB
FOT
FSIO
GN
GSFC
GUI
HK
HSIO
KFTP
LRS

Applications Process Identifier

American Standard Code for Information Interchange
bit error rate

command and data handling

Channel Access Data Unit

Consultative Committee for Space Data Systems
command link control word

command

Customer Operations Data Accounting
command operations procedure

Cyclic Redundancy Check

Distributed Active Archive Center

dynamic random-access memory

Deep Space Network

EOSDI S Backbone Network

EOS Data and Operations System
Expeditied Data Set

Exchange Data Unit

EOS Operations Center

Earth Observing System

Earth Observing System Data and Information System
Earth Sciences Data and Information System
EOSDIS Test System

Forward Link Physical Port

Forward Link Status Block

Flight Operations Team

Frame Synchronization Input Output
Ground Network

Goddard Space Flight Center
graphical user interface

housekeeping

High Speed Input/Output

Kerberosfile transfer protocol

Low-Rate System (ETYS)
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MPS
MVME

OMDSM
OSF
PDB
PDOS
PDS
PSS
RB
RISC
RLPC
RLPP
SCS
SCS
SN
TBD
TDRSS
TGT
tim
TSS
uTC
VCDU
VCID
VME
WGS

Multimode Portable Simulator (ETS)
Motorola Versa Module Eurocard
Operations Management Data
Operations Management Data Simulator
Open Software Foundation

project data base

P? Disk Operating System
Production Data Set

portable spacecraft s mulator

rate buffered

reduced-instruction-set computing
Return Link Physical Channel
Return Link Physical Port
Spacecraft Contact Summary

source sequence count

Space Network

to be determined

Tracking and Data Relay Satelite System
TDRSS Ground Terminal

telemetry

TDRSS Summary Session

Universa Time Coordinated

Virtua Channel Data Unit

Virtual Channdl Identifier
VersaModule Eurocard

Wallops Ground System
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Index

AM-1 (see EOS-AM1)

auto/static fields 7

CADU 42

CCSDSVCDU pand 33

check buttons 5

CODA 42

CODA report 8, 15, 28, 29

CODA Report Content Indicators panel 29
CODA transmission 11, 16, 26
communicationslink 15, 22
communications ports 22
conventions 1

DAACH9

dialog boxes 2

dialog boxes, confirmation 2

dialog boxes, display only 4

dialog boxes, file selection 3

dialog boxes, multiple modification 2
dialog boxes, primary 2

dialog boxes, prompt 2

directives 19

EBnet 8, 14, 22

EDOS9, 30

EDOS ground message header 34
EDS delivery record 27

EDS ddlivery record (see dso PDS/EDS ddlivery record) 27
ellipsis2

environment variable 11, 22, 25, 27, 28
environment variables 11
environment variables (OMDSIM) 11
EOCS8, 9

EOS-AM109, 16, 29, 42

EOS-PM1 16

EOSDIS 8, 9, 19, 42

eXceed 10

Exchange Data Unit Label panel 35
fields, auto/static 7

fields, list 6

fields, text 6

File menu 22

File menu (OMD Editor) 38
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File menu (OMDSIM) 14

file, OMD template 28

file, scenario 9, 10

FLPP 42

Forward Link Status Block panel 33
ground message header 11

Ground Message Header panel 28
help 39, 40, 41

Help menu (OMDSIM) 15

HRS 8, 9, 10, 11, 16, 22, 34
Kerberos FTP 19

keyboard focus 2

list fields 6

log file 24

log file, viewing 39

log files9

LRS 8§, 9, 10, 11, 16, 22

main window 9, 11, 12, 14, 17, 18, 19, 20, 22, 42
MD file 39

Menu Controller 11, 44

MPS 8, 9, 10, 11, 16, 22
MVME-187 10, 12

OMD Editor 8, 9, 11, 28

OMD editor window 28

OMD file 14, 17, 22, 23, 24, 38, 39
OMD received 14

OMD received panel 20

OMD template 8, 9, 10, 11, 14, 15, 16, 17, 18, 19, 26, 27, 28, 38, 39
OMD templatefile 28

OMD templates 8

OMD transmission 9, 11, 14, 16, 17, 19
OMD transmission panel 19

OMD transmission tests 9, 10

OMD transmitted 14

OMD transmitted panel 20

OMD type 26, 27, 28, 38

OMDSIM Help menu 40, 41
OMDSIM main window 10
om_delog 40, 42

OSF/Matif 1

pandl sizing bar 18

panel sizing bars 6

panel, OMD received 20

panel, OMD transmission 19
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panel, OMD transmitted 20

panel, scenario execution 18

pandl, status log 20, 22

PDS/EDS acceptance notification 8, 9, 24
PDS/EDS delivery record 8, 15, 24, 28, 34, 35, 38
PDSEDS Dedlivery Record Labd panel 35
PDS/EDS delivery records 9

radio buttons 5

rate-buffered 8

Return Link Physical Channel panel 30
scenario 14

scenario execution 17

scenario execution panel 18, 19

scenario execution tests 9

scenario file 9, 10, 14, 15, 17, 19, 22, 23, 24, 25
scenario file (OMDSIM) 11, 26
SCSreport 9

SCS Summary delay 9

session log 11

sessionlog (OMDSIM) 11

Setup menu (OMDSIM) 15

shutdown 44

spinners 6

status log 11, 14, 18, 22

status log file 22

status log panel 20, 22

stop the scenario 19

summary delay 19

telemetry generation 19

test duration 9

test summary 19

text fields 6

transmission interval 9

transmission test 16, 17, 24, 39

VCDU 42

VCID 42

View menu (OMDSIM) 15

X Window System 10
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